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© Copyright 2015 Tony Laidig 
All Rights Reserved. This guide may not be reproduced or transmitted in any 
form without the written permission of the publisher. Every effort has been made 
to make this document as complete and accurate as possible. Although the 
author and publisher have prepared this document with the greatest of care, and 
have made every effort to ensure the accuracy, we assume no responsibility or 
liability for errors, inaccuracies or omissions. Before you begin, check with the 
appropriate authorities to insure compliance with all laws and regulations. 

This document has been written to provide information to help you create 
professional-quality physical and digital products.  Tony Laidig is not directly 
associated with any of the websites mentioned in this document. All trademarks 
are the property of the respective owners.   

Every effort has been made to make this document as complete and accurate as 
possible.  However, there may be mistakes in typography or content. Also, this 
document contains information on online marketing and technology only up to the 
publishing date.  Therefore, this document should be used as a guide – not as 
the ultimate source of Internet marketing information. 

The purpose of this document is to educate. The author and publisher do not 
warrant that the information contained in this report is fully complete and shall not 
be responsible for any errors or omissions. The author and publisher shall have 
neither liability nor responsibility to any person or entity with respect to any loss 
or damage caused or alleged to be caused directly or indirectly by this report, nor 
do we make any claims or promises of your ability to generate income by using 
any of this information.   
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Session 1:  FOUNDATIONS 
The current coloring book trend creates opportunity for generating income. People who 
buy coloring books buy more than one just like people who buy cookbooks and journals!  
Coloring is relaxing and creates a sense of sanity in their 
lives. Just as the driving force behind the success of 
coloring books is relaxation and de-stressing, the creation 
process ALSO provides that to the artist. 

We are taking people on a journey with our coloring 
books. Their individual choices of color and “look” add to 
the journey and expressiveness. Understanding this is 
key for us to choose niches and images to serve those 
niches.  

Understanding the topics that interest people and are part 
of human psyche is key to success in this niche. An in-
depth look at the bestselling coloring books on Amazon 
reveals what is most popular. What is selling best?   

• Mandalas are huge 

• Nature Scenes (e.g. Secret Garden) 

• Geometric Patterns (e.g. fractals) 

• Plants and Animals 

• Natural Patterns 

• Inspirational Designs (sayings with illustrations) 

It isn’t just that we find it relaxing to color these elements. 
It is relaxing because it is part of us. We naturally (human nature) respond to these 
elements. It is hard-wired into the human psyche to respond to these mathematical-
based (ALL are) elements.  

It isn’t just about pages to color. You are an artist and it 
is your job to take your customers on a journey. How 
can you do it? 

• Use themed images of a specific genre or niche 

• Use “easter eggs” (hidden messages) in your 
drawings 

• Tell a story (with no words at all or include words if 
you want) 

• Encouraging words or quotes (which can be 
outlines for purpose of coloring or not) but 
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remember this is NOT a quote book so use sparingly 

• Hidden objects, messages, etc. (one of keys to success of Secret Garden) 

You have an opportunity to experiment with your coloring books as long as it makes 
sense. You cannot please everyone and you MUST remember this. But, just because 
some people want everything in outlines doesn’t mean you cannot include a lot of black 
in your experiments. This is an expression of you and some people — your customers 
— will respond favorably to that. Other people will never get it no matter what you do!   

Mash up ideas in your experimental blender. For instance,  

• include lines mixing up coloring books with journals (e.g. a coloring journal for 
writers). There are not a lot of coloring books being done like this, marrying together 
more than one very personal element, but it could be that the trend moves that way 

• use partially drawn illustrations the customer can complete 

• weave a story throughout with words and images 

It is just important that you have a clear idea of where you are headed before you begin!  
Know your theme and direction you want to take your book, either with words/phrases/
quotes/hidden messages, etc. or not. Don’t start with an Alice in Wonderland theme and 
then suddenly decide you are going to make it a zombie coloring book.  

A few important things to keep in mind… 

• The biggest non-production related complaint is complexity, so don’t get hyper-
detailed in small images!  Detailed images are best-sellers, but the details are sized 
so that these details can still be colored. If you cannot color with a medium-tip pen, it 
is probably too finely detailed. Some images (which get lots of complaints on 
Amazon) cannot even be colored with a colored pencil!  Customers don’t like it. 

• In many ways, coloring books are related to the journaling market 

• Think about creating series of books, not just one. Don’t think of this as a one-time 
thing. Your target audience buys a LOT of coloring books. They collect them. 

• Establish a look and feel that is consistent throughout the book. Style should be 
consistent throughout ALL the designs. If you use thick lines, use them all the way 
through. If you use thin, wispy line, use them all the way through. 

• Use hand-drawn or digital or both. Just be consistent 

• Use the page smartly. You have a canvas the size of your page. You don’t have to fill 
every inch of it necessarily but it should be designed and laid out well. Illustrations 
should fit well on the page. Some books get complaints because though the 
illustrations are beautiful, they are too small for the page size of the book. Look at 
other people’s coloring books. Some of these artists have been doing it a long time 
and have it down to a science. There are right ways, things that look more 
appealing, and wrong ways to design your positive and negative space. 
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• Have a rough idea of page count from the start. Aim for 24-48 (divisible by 4) 
illustrations as a MINIMUM for 48-96 pages plus any front or back matter. DON’T 
USE BOTH SIDES OF THE PAGE. 

• Images MUST be 300 dpi at your page size. If you are creating an 8” X 10” book, 
your image must be 2400px x 3000px 

Session Q & A 

Q:  You need to be consistent in the book itself but do you need to be consistent in a 
series, i.e. can you have one book on one subject and one on another or one that is a 
story while another has a journaling component. 
A:  It could go both ways. If you have a whole series of books you are producing, they 
don’t have to all look the same stylistically, but they certainly can. Within each individual 
book in the series there needs to be a consistent element running throughout. For 
example, if you are using thin lines in one, use a thin line throughout the series.  

Q:  Do types of pens/pencils dictate the detail you can have in a coloring book image 
A:  To a certain extent they do. I will talk more about it in session 4. 

Q:  Any demographic or psychographic information on who is buying coloring books? 
A:  No formal studies I’ve seen but anecdotal evidence suggests market tends to be not 
exclusively but majority female. Age range is all over the place.  

Q:  Is it possible to just use an iPad to create coloring books? 
A:  Absolutely. In some of the iPad apps, you can do things you can’t do on any 
desktop. 

Q:  What is favorite coloring tool? 
A:  Colored pencils, Prismacolor brand to be exact 

Q:  You said city themes are  popular. What types?   
A:  When it comes to themes, sometimes it can be very beneficial to plug in to regional 
ideas.  Pay attention to what is going on around you. One of the reasons I chose Alice in 
Wonderland theme is that this year is 150th anniversary of the book so I can capitalize 
on promotions and marketing being done by marketing giants like Disney. There are a 
lot of things to keep in mind when you are deciding what you want to publish. If you go 
outside the themes I’ve discussed, there has to be a hook, a reason why. 

Q:  Odd that best-selling books are the most intricate ones but most complaints are 
about difficulty to color due to complexity.   
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A:  While some of best books are hyper-detailed, the details themselves are large 
enough that you can color them. Complaints come when details are so tight you cannot 
get a colored pencil in between space to color.  

Q:  Site other than Amazon to sell books if cannot sell on Amazon? 
A:  There are options for expanded distribution you can tap into. I will discuss publishing 
and distribution in a later session 

Q:  If only have PC, can we still create pretty nice coloring book? 
A:  Absolutely 

Q:  Do you create books specifically for men and different ones for women? 
A:  No. You don’t need to be that specific. Some are going to resonate with certain 
people and not with others. That is just the way it is. 

Q:  What is realistic time frame in which to complete a coloring book if starting from 
scratch 
A:  Depends on how much time you have to spend on it. A week is possible, but for 
people who are working and with other commitments, two weeks is more realistic.  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Session 2:  ILLUSTRATION TECHNIQUES  

Software we will look at: 

Kaleidoscope Kreator (PC):  http://www.kalcollections.com 

Photoshop (PC/Mac):  http://adobe.com 

Mandala Maker (PC/Mac):  http://www.mandalamaker.net 

Pixelmator (Mac):  http://www.pixelmator.com 

ScopeWorks/FractalWorks (Mac):  available in the Apple Mac Store 

Wordify (Mac):  available in the Apple Mac Store 

Symmetry Lab (iPad)  CraZe (Android) 

Percolator (iPad) 

WordFoto (iPad)  WordCam (Android) 

Online Resources 

LunaPic (online),  http://www.lunapic.com 

Pho.To (online/iPad/Android):  http://funny.pho.to/creative-photo-effects/ 

Ribbet (online):  http://www.ribbet.com 

Inspirograph (online):  http://nathanfriend.io/inspirograph 

Resources: 

Fractals:  http://fractalarts.com/ASF/download.html 
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Images to Vectors:  http://www.vectormagic.com 

clker.com 

OpenClipArt.org 

pixabay.com 

PublicDomainVectors.org 

i2clipart.com 

VectorPortal.com 

© Copyright 2015 Tony Laidig Page !  of !9 91

http://www.vectormagic.com
http://clker.com
http://OpenClipArt.org
http://pixabay.com
http://PublicDomainVectors.org
http://i2clipart.com
http://VectorPortal.com


Coloring Book Master Class Tony Laidig

DEMONSTRATION:  Software Technique 1, 

turning scenes into illustrations 

1. Select the images you want to use. In this 
demo, I will go to Pixabay, looking for a 
beach scene photograph and a simple 
black and white flower image, something 
easy to color that we can create something 
further from. Download the extra-large versions of all the images you choose. 

2. Open Photoshop > Open image in Photoshop.  NOTE:  this is a methodology. You 
could use this same general method in another image editing program. 

3. This image has some very strong dark areas and will work better for us if those 
shadows are lightened:  Image > Adjustments > Shadows & Highlights > highlights 
slider up a little from zero to 26% 
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4. To turn this image into the start of a coloring page, there is a specific technique in 
Photoshop:   

A. Duplicate the Background Layer 

B. On copy layer:  image > adjustments > desaturate to get black/white image 

C. Duplicate b/w layer > Cmd/Ctrl I to invert (or to use the menu: Image > 
Adjustments > Invert) 

D. Set Blend Mode to Color Dodge (image will turn white as if it has disappeared) 

E. With this layer still selected: Filter > Blur > Gaussian Blur. This will create an 
outline of the edges in the photo. Experiment with the settings. The right amount 
of radius varies from photo to photo. You can go too far, so you just have to 
move the radius slider to find what looks best.  

F. Merge together the two copies made from the 
background layer: Select the two layers > 
right click > merge layers. 

G. This image is too light and too detailed for 
coloring pages. Fix this with Levels:  Cmd/Ctrl 
L (Image > Adjustments > Levels) to bring up 
Levels adjustments > move sliders shadow 
slider (far left) to the right to darken > move 
highlights slider (far right) to the left to get rid 
of some detail. Move the three sliders back 
and forth to find the best position to get the 
darkest necessary detail while getting rid of 
the most unnecessary detail. It is just an 
experimentation. 

5. Now,  we have the image below and we still need to get rid of some detail like all the 
sand in the lower portion. The fastest way to do this is using Adobe Illustrator which 
will also convert the image into a vector image so it is infinitely scalable:  Cmd/ctrl A 
(Select > All) > Cmd/ctrl C (Edit > Copy) 
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6. Open Adobe Illustrator > File > New > Cmd/ctrl V (Edit > Paste). NOTE:  you could 
also save the Photoshop image as a .jpg and take it into VectorMagic.com to 
achieve the same basic end result 

7. Click Image Trace to convert it into a vector image. We also lost detail. Control how 
much detail is shown or lost using the Threshold slider. The further you move it to 
the right, the more detail is added back in. 
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8. The image still needs some work to clean it up:  Cmd/ctrl A (Select > All) > Cmd/ctrl 
C > go back to Photoshop > Cmd/ctrl V to paste the traced image into Photoshop > 
select “Pixels” 

9. Polygonal lasso tool > click along the edge of the houses as detailed as you want to 
be and then select the sand area at the bottom of the image > Edit > Fill > White. Do 
the same thing with the ocean which isn’t adding much to the image . Follow the 
contours of the roofs of the houses and select the ocean > Edit > Fill > White. 
Mountain is kind of weak. Select it and fill with white to remove it or pick a paint 
brush (10 pt) with black paint and fill in the edge. Choose a white paintbrush and 
paint away some of the dirty areas or extra details. 

10. The coloring page isn’t complete. There is a lot of white space and much more we 
can do with the image. We can fill the sky and sand area. With what?  Go back to 
Pixabay and look for sea shell vectors, download what you want and open in 
Photoshop. You can see from the choice here (image below left), the background is 
transparent. We need this to be white because if we start creating a replicated 
pattern of the seashell, it is going to overlap because of the transparency. Easiest 
way to do this is to take the magic wand tool, click on the outside area(s) of the shell 
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> Cmd/ctrl Shift I (Select > Inverse) to select the area inside the shell > Create New 
Layer and move it below the shell layer > Edit > Fill > White > merge layers 

11. Cmd/ctrl A (Select > All) > Edit > Define Pattern, name the pattern 

12. Go back to the beach scene. In order for this to work, we must have a confined 
space in the image with an unbroken outline or line between that area and all 
adjacent elements. For example, if I select the sand area using the magic wand tool, 
you will see it also selects some or all of the houses. That is because somewhere 
there is a broken line between the sand area and the houses so when i select, I am 
getting everything that is not confined. That won’t work. To fix this, I can paint a solid 
black line across the base of the houses or find the broken areas and paint them in 
or use the polygonal lasso tool to select the beach and make it active > create a 
new layer > keeping the selection active, Edit > Fill >  Contents  > Pattern, Check 
“Script” and choose Symmetry Fill. You will see a pattern is created with the 
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seashell. In the drop down for Symmetry type, there is a list of different fill options to 
experiment with (samples below) in getting the look that works for your image. We 
are looking for something to fill the sand, and of course,  you can vary the scale of 
the pattern, amount of space between pattern elements, etc. just by moving the 
sliders. 

13.  If you click Okay, the selected area in the image will be filled with your choice. It 
may or may not look good to you. In fact,  this isn’t pretty at all. The point is you 
have a technique, and you are going to have to experiment with type and scale of 
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the pattern to get an image that suits you for your coloring page. For the sake of the 
demonstration, let’s say this looks great so we can look at other options. 

14. Now use the shell to create a different kind of pattern:  Cmd/ctrl D (Select > 
Deselect) to deselect the sand selection (because we are going to work on a 
different area of the image) > create a new layer > Edit > Fill > Pattern > and this 
time choose #9 as Symmetry type. Now we have a sun. There is way too much 
detail in this but we can use the ellipse tool to select the middle area and fill it to 
white, put a black stroke around it (Edit > stroke > black, 8px) and even paint out 
some detail. 

Alternate Technique: using Photoshop Plugins to achieve the same result 
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Photoshop plugins like Topaz Glow or SnapArt 4 can give you similar results. Obviously 
there is a cost involved in purchasing the plugins so you have to decide if it is worth it to 
you or not. 

Glow has a lot of different presets they’ve created. You 
can start with their Sketch Outline and modify it to create 
your own versions. My settings for the version I have 
created (image above) are as shown in image right. 

You will notice there are still a lot of grays in this image. 
Repeat the same process of copying the image and 
pasting it into Adobe Illustrator > apply Image Trace with 
threshold adjustments to get rid of a lot of the extra 
details. 

Another option to taking the image into Illustrator is back 
in Photoshop: Image > Adjustments > Threshold and 
adjusting the slider. Threshold converts everything in an 
image to either black or white.   
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Or, you can use Levels, Cmd/ctrl L, to adjust the levels sliders as we did before to refine 
the image until you get to something pleasing (image below). It is not a perfect science 
so you have to spend time tweaking your images, but compared to the time it would 
take to draw them from scratch, it is much simpler to get you to your end goal. 

Another plugin option is AlienSkin’s SnapArt. Their preset for Line Art is a good start to 
make adjustments in creating your own preset.  

There is no “one size fits all.” Every image is different and will respond differently to a 
particular technique or preset. You just have to find what works best for a particular 
photograph. 
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A web based option is Pho.To > scroll to Creative Photo Effects > Edge Detection > 
upload photo. You get an interesting image (below). You can see in the beach scene 
that it really strips out a lot of detail. The downside to this site is that it makes all the 
images low resolution, but you can open the saved image in Illustrator  and use Image 
Trace again to create a scalable vector image. Because it is vector, you can scale it to 
any size you want and it will still be clean. 
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DEMONSTRATION:  Working with Type in Coloring Images 

In Photoshop,  there are some cool things you can do with type. 

1. New layer over beach scene > bring in a 
center guide line by dragging from the left 
ruler and snapping in the center. On new 
layer, use rectangular marquee tool to draw a 
box in the left half of the image > Edit > Fill > 
Black 

2. Filter > Distort > Twirl > Angle to 999 > OK > 
apply it again (result below) 

3. Make a selection of the black twirl layer by Cmd/ctrl 
click on the layer thumbnail in the layers list (image 
right). 

4. Click on Paths tab > click Load Selection > from 
drop down menu select Make a Work Path > turn off 
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this layer (click on its eyeball in layer list) because you have a path and no longer 
need the layer. 

5. Create two new layers below that layer, fill one to white (just so you can see what 
you are doing). On the other, select the text tool, pick and area on the path. You will 
notice that as you move the text tool around the path, the cursor changes from a 
cursor in a circle to one with a little wavy 
line. Click the wavy line in the place 
where you want your text to start and 
type. Notice how it starts following the 
path. You can adjust the text in the same 
way you could adjust any text. 

6. Make the text white by inverting it. It will 
disappear because it is white against a 
white background. Right click > blending 
options > stroke and you now have 
outlined text that you can move around in 
your scene and make a part of your coloring page. The text can now be colored the 
same as the rest of the image. The best part is the text is still fully editable. If you 
want to add to it, just click in the text and type. NOTE:  where you first click on the 
path determines the starting point for your text. You always want to make sure your 
paragraph is aligned to the right so your text will flow outward. 
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DEMONSTRATION:  Kaleidoscope Kreator for PC 

Kaleidoscope Kreator is a PC only software. It essentially lets you create mandalas. 

1. Open an image. This will work with any image. We are working with black and white 
images because we want to be able to make coloring book images 

2. There is a black wedge behind the image. What is inside the wedge 
controls what is created in the kaleidoscope. By left mouse clicking 
and moving around the imported image, you can change the part of 
the image that falls inside that wedge.  

3. You have a lot of different ways of controlling what is created here. 
Across the top is a selection of tools. Select the wedge and you get a 

further selection of controllers or different 
kaleidoscope shapes that can be made using a 
wedge. 

Sometimes, the smallest of movements can 
really change the look of an image. Just by 
changing these selections and moving your 
image around inside the wedge, you can get an 
endless variation on a theme from that same 

© Copyright 2015 Tony Laidig Page !  of !22 91



Coloring Book Master Class Tony Laidig

image like: 

 

4. To use this, File > Save Kaleidoscope > 2400 px wide (8” x 300 ppi) for an 8 x 10 
book page, 300 ppi > save as jpeg.  

5. All the extra stuff on the outside of some of these is not helping. Open this image 
into Photoshop > drag horizontal and vertical center guides out from rulers > select 
circle marquee and holding shift key down to make sure the marquee is constrained 
to a perfect circle draw out to select the entire image > move it to make sure it is 
centered.   

6. While the marquee selection is still active > copy background layer > Select > 
Inverse to invert the selection > delete to remove anything on the area outside the 
marquee > turn off the background layer. Now, you have a circle. 

7. With selection still active > right mouse click > blending options > stroke to add a 
constraining border around the mandala (image below). 
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To try another image, save this kaleidoscope (below left). Take into Photoshop. The 
problem is there is all the black so you couldn’t color it. Cmd/ctrl I inverts the image, 
sharpen it up using Image Trace in Illustrator and you have another image page. 

Let’s try with a different image. 

Open the seashell in the software, put the top part in 
the wedge. You get a great little pattern. Considering 
all the images available to you in Pixabay and other 
resources, the sky is the limit in making images like 
this.  

DEMONSTRATION:  Mandala Maker 

This program is completely different from any of the other software packages we will 
look at today.  

1. Lower right corner > New Shape. In drop down menu, upper 
left, you can choose from among various shapes that it will 
create such as Yantra. 

2. Line and fill lets you control how thick or thin the line is. By 
moving sliders int the shape palette, you can control the 

© Copyright 2015 Tony Laidig Page !  of !24 91



Coloring Book Master Class Tony Laidig

number of triangles in the Yantra, the radius 
and rotation. 

3. The way this program works is that you 
create a series of shapes and put them 
together. Everything is auto-centered. If you 
create a new shape, it adds it into the layer 
palette (right). By changing controls, you 
can create an entirely different kind of 
image — a mandala built from scratch from 
a totally artistic perspective. You can make 

them as simple or as complex as you want. If you want to get rid of a shape, select 
that layer > choose the drop down in upper right corner and choose Delete 
Selected. 
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4. Once you have an image you want, save it. Then File > Export Mandala, jpeg/300 
ppi resolution/8 inches square 

5. Open image in Photoshop if you want to add something else or manipulate the 
image further. 

DEMONSTRATION:  ScopeWorks 

Scopeworks is another program that creates mandalas. Like a lot of this type of 
program, when you open an image, it takes a triangular slice to create the mandala. You 
can move the location of the triangle as well as change some of the details like type, 
rotation, etc. 
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This program is simple to use and you have a lot of options with it. It will do grids and 
tiles as well as a variety of kaleidoscope styles.   

Best of all, you can animate it and let it run. It will move the triangle around and when 
you see something you like, you can just pause the animation and save the image. Hit 
start again and it will continue again. The result you get is largely dependent on your 
source image. The simpler your image is, the better the result is going to be because 
this can create complex images pretty quickly. With one image, you can literally create 
an entire book of these images. 

DEMONSTRATION: Wordify 

Wordify basically works like this:  you type in words you want to use and then drag/drop 
and image into the canvas. It takes the image and everywhere it is black, it turns the 
black lines into those words you typed. This program is not intended to be used for 
coloring books, but it can be interesting…  

1. Create a new document in Photoshop, 8 x 10.  
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2. Select a font and type some text > flatten image > save as jpg. NOTE:  I could use 
anything for my graphic. I just chose to make type into a graphic for this. 

3. Open this jpg image in Wordify. Click on the type and type your words (Tony is 
Awesome), choose font, color, size, alignment (random is usually fun), etc. Set 
output to be .pdf because it vectorizes the image so you can scale it to anything you 
want. 

4. Click Play and it will fill Tony is Awesome .jpg with more Tony is Awesome (image 
above right). 

5. Open this image in Photoshop at the same 
size it was originally, 8 inches. Drag it over 
the original image and scale down so they 
line up with solid black layer on top. Select > 
color range > black (you should see the 
marching ants around all the black words). 

6. Create new layer > stroke of 8 > deselect > 
new layer below > fill to white (so we can see 
what we are doing) and you get an outline 
around the Wordify graphic (image below). 

7. Lock the Wordify type layer and fill to white > right 
mouse click > blending options > stroke > and you have 
text that can be colored (below). Using stroke, you can 
choose for the position to be inside, outside, or center. If 
you choose Inside, as 
you expand the size of 
the stroke, it starts to 
fill in some of the 
smaller areas so they 
are not as prominent 
and basically are 
eliminated to remove 
the crowding for 
coloring. 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Session Q & A 

Q:  When you use trace in Illustrator, do you have special presets set up or are you 
using defaults? 
A:  Defaults 

Q:  Are there alternate programs besides Photoshop? 
A:  Yes. Gimp Shop is similar and is free; but you can get the best image editor on the 
planet — Adobe Photoshop — for $10 per month. You are talking about creating a 
product for your business and you have to be willing to invest 30¢ per day or you 
probably shouldn’t be trying to be in business. Yes, there is a learning curve with 
Photoshop, but if you are serious and want to be a designer, it is an absolute MUST 
LEARN. The basic training from my step-by-step Photoshop course, PS Instant Expert, 
has been included at no charge on the course page for this class. USE IT. Students who 
use it swear by it. 

Q:  Once happy with images, should they be saved as jpg or png? 
A: JPG makes the most sense 

Q:  Alternative for ScopeWorks on PC? 
A:  Not sure. After a pretty intense search for software, there just isn’t as much for PC 
as there is for Mac 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Session 3:  MORE ILLUSTRATION TECHNIQUES 
How do you get your images onto your iPad?  There are several ways, but Dropbox is a 
great option. With the app installed,  you can access files there from any of your devices 
regardless of where you are. Simply upload the files to Dropbox to make them available.  

You can see from this image below, several of the images we are working with have 
been uploaded into the desktop Dropbox app into a new folder. By having these images 
in a Dropbox folder, you can open the app in the iPad, choose Save Image and it saves 
the image right to the camera roll. Repeat this for each of the images you want to save 
to your iPad camera roll. The same works in reverse. Uploading files into the Dropbox 
from the iPad, they will be available for saving onto the computer. 
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DEMONSTRATION:  Symmetry Lab 

Symmetry Lab is another mandala-generation program. Selecting the gears at the 
bottom brings up the settings where you have multiple brush styles, control over the 
brush size and other settings. There are presets based on color schemes, but we are 
not interested in that.  

We are working on a black background, and continuing up in the tool bar, the rainbow 
icon represents the current color in use. Tap the plus sign and change this to white so 
we will work with white on black. 
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The tool is simple to use. You hold your finger to the screen and move it around to 
create lines. Based on the position and movement of your finger(s), it controls what the 
app draws 

If you decide you don’t like it, tap the trash can and it throws it away.   

Next to the trash can is a play button. Select it and 
the app starts randomly creating patterns. Going 
back to the settings menu, choose Square. Now 
when you draw, everything is a little more blocky. 
Jagged is similar to Squares, but lines are even 
more jagged (image right). It would be a good 
option if you want to to do a grunge coloring book. 

It is easy to use and in a few minutes you can 
make some very interesting designs. When you 
have something you like, tap the up arrow tool and 
you will get the option to save/print/email, etc. 
your image. Save and it is saved to your camera 
roll. With the image selected in your camera roll, 
select the box with the up arrow > Dropbox > 
choose folder > save.  

Now the image is in your dropbox and you can 
access it on your computer to invert the image 
from white on black to black on white in 
Photoshop. 

Open the image in Photoshop > Image > 
Adjustments > Invert. You have a new coloring 
image. 
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DEMONSTRATION:  Percolator 

This app is a totally different approach but simple and straight-forward to use. Open app 
> tap the camera roll in lower left corner to bring up access to the photo library > choose 
camera roll and choose the owl we added from Dropbox. It essentially “brews” circles. 
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Based on color and shape, it creates different sizes of circles. For example, because 
this particular piece of clipart had gray in it, there are gray circles. 

You have a few options for 
changing the way the image 
looks. Tap the coffee cup. 
You will see under Grind that 
you can change the size of 
the circles from extra fine to 
fine to medium. If you 
change the line size, you 
then tap the Re-Grind button 
and it redraws the image 
with thicker lines. 

Tap the cup again > in Brew, 
you can choose to fill the 
image with something other 
than circles, something like 
stars > tap the Re-Grind 
button and it redraws the 
image. Not all of these will 
be suitable, but there are 
some interesting options. 
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Notice in each of these menus there is a little arrow to the right. If you click on these, 
you will get extra controls like the intensity of the fill.   

Finally, you have “Serve” or controls for Color 
(below). Because we are making coloring book 
pages, it makes sense to stick to black. Not all 
of the options would work well for coloring 
pages but you can experiment to find 
interesting combinations that do work. 

In addition to using clip art, you can create type 
as a jpg as we did in the demonstration of 
Wordify and use that for some interesting 
effects. 
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DEMONSTRATION:  WordFoto 

In some ways, WordFoto works like Wordify 
but with different controls. In Wordify,  the app  
filled everything that was black with words. 
This app is the opposite and fills everything 
that is white. 

Selecting Words > you can choose default 
word sets that come with the app or add your 
own.   

Selecting Add new Word Set will bring up the 
keyboard so you can type your own words. 
The app then fills the image with those words 
in no particular order. 

The next set of controls is Style which gives 
you control over how the words fill. For 
example, choose Black Label and you will get 
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a totally different look (below left) using the same type. Not all of the various options will 
work for a coloring book, but again, you can experiment to find what works for you. 

Finally, you can choose Fine Tune to adjust edge 
control and color tolerance. Using a black and white 
stock image, the edge threshold is not going to have 
much effect, and of course, there is no color so color 
tolerance is irrelevant. With a photograph, that would 
be completely different. 

Save the image to the camera roll as before and from 
the photo library, upload to Dropbox. 
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An interesting option is that you could create this text in the white areas in this app, 

save it, import it into Photoshop and then layer the outline of other elements made with 
different apps and then assemble these together as layers in a Photoshop document 
like in the image below. The fun comes from experimenting and being creative. 
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DEMONSTRATION:  Photo Lab 

Photo Lab, the app from Pho.To, works the same on the iPad or Android device as it 
does on the web. Essentially, the app uploads the file to their web site, does the 
conversion, and then delivers it back to you in the app. So regardless of which way you 
do it, you are going to get the same end result.  

There are numerous categories and effects within those categories. Scroll through the 
app and make selections to find looks you like. For coloring books, most of these will 
not work, but there are some worth experimenting with. The one we used on the web, 
Edge Detection, is also in the app:  Fancy Filters > Edge Detection (image below).  

The app also has a 
Kaleidoscope effect inside 
Fancy Filters. Looking at the dog 
and rabbit images using that 
effect, we can see what it does 
(images on following page). 

The biggest problem with this 
app is that you really don’t have 
much control. There isn’t real 
variation on a theme. You just 
open your image and select a 
filter. If you do decide you like an 
image and want to use it, tap the 
upload screen where you can 
Save to Gallery. 

DEMONSTRATION:  Lunapic 
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Lunapic has been around for quite a while. It is pretty straight-forward but there is a lot 
to explore with over 200 effects and more. Only a few of these are going to work for 
you, but one nice thing about this site is where some web-based programs don’t, this 
one maintains resolution. 

1. Coloring Book Effect:  select a photo > Effects > coloring book. It is “Find Edges” 
again, but you get a totally different look. That is why it is important to try out 
different programs since all of these are applying Find Edges Filters and no two look 
the same.  

2. Effects > Kaleidoscope. You may or may not like their kaleidoscope feature. You 
don’t have a lot of control,  but you can control number of sides or click on an area 
of the image to re-center and 
it renders again. If you use a 
black and white image — the 
simpler the better — you are 
going to get a much better 
image. Using the dog photo, 
we get image right. It isn’t 
very appealing.   

Using a simple flower vector 
(below left), we get a much 
less grungy kaleidoscope 
image (below right). 
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This is a great site for experimenting. Play, have fun with it. There may not be a lot of 
effects that are useful to us for making a coloring book, but maybe you will create some 
very interesting coloring book pages. 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 DEMONSTRATION:  Ribbet 

This is another interesting photo app that works in full resolution. Like most of these 
apps, this one has various editing features; but what we are interested in looking at is 
the Effects. There are a lot of effects here that will probably be useless to you, but scroll 
through them and find effects like Etch-a-Sketch or Pencil Sketch that might be useful to 
you at some point. 

Applying Pencil Sketch to our dog photo, we get this: 

You have some controls with the 
effect. You can strengthen the 
effect if you want or  fade it. 
When you are finished, hit Apply 
to change the image. 

© Copyright 2015 Tony Laidig Page !  of !43 91



Coloring Book Master Class Tony Laidig

Some of the other interesting effects are Waterfall, Ripple Blocks, Hypnotic (which is 
kind of a kaleidoscope effect) and AdjustableThreshold. It is possible that none of the 
effects here will be useful to you in and of itself in creating a coloring book image, BUT, 
if you create one or more of these unusual images and take it into one of the 
kaleidoscope making techniques we reviewed, or into Pixelmator or as a layer in 
Photoshop combined with other image effects, you can get some very interesting and 
unique results. It only takes some experimenting.   

 

Technique:  Mashups 

Mashing up ideas from images created in 
different programs can help you create some 
fantastic images. For example, the image right 
was created as an experiment using the 
Waterfall and Ripple Blocks effects. It looks 
utterly useless. But taking this into software like 
Pixelmator and using the Kaleidoscope effect, 
this turns into some beautiful images (below)  
You can only get these distinct lines in a 
kaleidoscope image by having distinct lines in 
the base image, so the waterfall lines become 
invaluable in creating these images. 
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DEMONSTRATION:  Inspirograph 

Inspirograph is basically a digital spirograph. Keep in 
mind in using this that we need black in our images 
and you have to set black as a color in this program. 
For whatever reason, their darkest color in the set is 
about 80%, so click on the black color box and drag the 
slider all the way to 100%. 

Just like with any spirograph. you put your “pen” into a 
hole and start drawing around. Then, when you are 
“finished” you can put your pen in another hole if you 
want and draw around again.  

Then, if you decide you want to do something 
completely different, select a different fixed 
and/or rotating ring from the selections on the 
left and draw again. Continue until you are 
pleased with the result. If you want to see your 
creation, click the eyeball and the gears 
disappear. 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Once again, this gives you the ability to 
generate potential coloring book patterns you 
might not have been able to create as easily 
using other methods. The one downside is 
the resolution. It works just at desktop 
resolution. If you click “download image,” it is 
not sufficient for print. it will not be a solution 
for you to use in print. That means you have 
to convert it to something that you can use in 
print by opening it in Adobe Illustrator or 
Vector Magic and using Image Trace to 
create a vector. Once it is a vector, you can 
scale it up to anything you want. In illustrator, 
you can try tracing it as line art. Instead of 
basically drawing an outline around it and 
filling with black, this essentially acts like the 
center line approach and may get you a 
cleaner result. 

Because of the resolution, something complex like the image below is going to present 
real problems. Some experiments can lead you to come up with some interesting new 
results. 

With spirographs, it is better to create a simple, individual drawing, say the star burst in 
the middle of this image, and save it. Then, create another component drawing and 
save it. Continue doing this with simple segments and then it is easy to layer them all 
together in Photoshop. That way you don’t have to worry about all the lines competing 
with each other to see where the path is going to be.  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DEMONSTRATION:  Using stock images 

If you go to Shutterstock one of the most popular, fastest growing stock images sites on 
the planet with over 15 million stock images and type into search “mandala.”  Take a 
look at some of the results: 

Some of these are fantastic and would be very challenging to create using the 
techniques I am teaching you. The image below comes in jpeg and vector formats. The 
jpeg is huge. This is a big deal because if you select the Standard License and read the 
usage rights, it shows for “physical reproductions such as books, magazines, emails, 
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advertising, posters and packaging”  “up to 500K.”  What that means is as long as you 
don’t print and distribute more than 500K books, you can use the Standard License for 
these images. You could take the images here on Shutterstock and mix and match 
images together to create new coloring pages and as long as your book doesn’t take off 
and sell more than 500,000 copies, you can use the Standard License. All you have to 
do is give a copyright attribution, name of the artist and Shutterstock, on your copyright 
page. 

Here is where it can get fun. In terms of pricing, they have different options, basic and 
professional. You can find deals on it. At the time of this presentation, you could get  750 
image downloads per month for $199 per month. You can put together an entire coloring 
book or series of coloring books for not a lot of money and all you have to do is give 
copyright attribution. 

You can find a lot of public domain images on Shutterstock. So why, if the image is 
public domain and available in many places for free online, would you pay for it?  
Because the person who created the vector did an amazing job. These are super-high-
resolution scans. 

There are a lot of great patterns on Shutterstock. Think about it. You could create a 
simple shape or outline of an object, download a pattern from Shutterstock like the one 
below left and use it to fill that outline, say of a cat, to create an almost instant new  
image. This would not be a good way to do an entire coloring book because it isn’t 
expressing real creativity, but it could give you a lot of ideas and even a head start on 
image creation for your book. 
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DEMONSTRATION:  Hand-drawn look with Adobe Illustrator 

If you do love to draw or would like to try, here are a couple of techniques in Adobe 
Illustrator to help you. Say you want to draw a bean pod and have cross lines  so people 
can color in between, but it can be very hard to get these lines to stop along the outline. 
You don’t have to. 

1. Open Illustrator > create new file > open a brush, a 
calligraphy or artistic brush and draw a bean pod. One of 
the nice things about drawing in Illustrator is even if your 
line isn’t smooth, it smooths it for you.  

2. Draw your cross hatch lines but don’t try to make them 
stop at the outline of the bean pod. 

3. Use direct selection tool to draw box around all of this 
and select it > Object > Group 

4. Object > Expand Appearance; Object > Live Paint > 
Make;  Object > Live Paint > Expand. This series of 
steps takes your drawing and segments it. Now that 
every line of your drawing is segmented, you can just 
lasso the lines that fall outside the outline (or use the 
direct selection tool to select individual lines) to select 
them and delete. 

You can do the exact same thing with importing images 

1. Open image in Illustrator > if not a vector, use Image Trace 
(Object > image Trace) to vectorize it > Object Expand. 

2. Get brush of choice and begin to draw in the same way as 
above. Here we will draw into a wing.   

3. Use direct selection tool to draw box around all of this and 
select it > Object > Group 

4. Object > Expand Appearance; Object > Live Paint > Make;  Object > Live Paint > 
Expand.  Now delete the lines 
outside the owl outline. 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DEMONSTRATION:  Photoshop 

1. New layer > fill to white  

2. Open transparent seashell image > Select All 
> Edit > Define Brush Preset, name it shell. It 
may be pretty big. You can go up to a 
maximum of 2500 

3. Back to new file created in step 1 > Open 
brush presets and seashell brush is there. 
Select it 

4. In the presets panel, you will see a number of 
settings like jitter, shape dynamics, etc. 
Selecting and adjusting these controls how 
your brush reacts on the page. You can see a 
preview of the effect at the bottom of the 
panel.  

• Shape Dynamics > Increase size jitter to 
vary the size of shells 

• Scattering > control  how close or far apart 
they are when you draw and jitter the count 
or number of shells that appear.  

Now, what happens when you draw? 

If you use a pen tablet,the pressure on the 
tablet will change the appearance of the 
brush 

All this just by using a Photoshop brush. 
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Session Q & A 

Q:  Apps only on iPad? 
A:  Those demonstrated on iPad are specific to iPad. When there was a similar Android 
app available, it was listed. 

Q:  Any advantage to using iPad? 
A: It all comes down to being able to do certain things on iPad you cannot do on your 
computer. Use what works. 

Q: Why save out as jpeg over png?   
A:  From a publishing perspective, you want to save final as tiff or jpeg when you 
publish 

Q: When you demonstrated the Ribbet Pixelmator mashup, there was a lot of colored in 
parts with the straight lines. How would you turn those dark areas white? 

 

A: Photoshop Technique 

1. Open image in Photoshop 

2. Lets say people wanted to color in the big black 
lines. How? 

3. Isolate that layer > put white layer behind it so we can see what we are doing > 
select layer > lock layer > Select > Color Range, black 

4. Create new layer > fill > white 

5. On new layer filled to white > right click > blending options > stroke about 8 px 
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6. Turn off white layer turn on Alice and Rabbit layer and there it is. 

7. Do the same thing with her hair or any large dark areas you want to have outlined. 

Q:  Border around finished image 
A:  Very often, yes. It depends on the image 

Q:  Resolution for print? 
A:  300 ppi 

Q:  If you do sell more than 500K books with Shutterstock images… can you upgrade 
your license 
A:  Yes. 

Q:  What about images in Graphic Stock 
A:  Read their licenses. Every stock site has different licenses and has its own rules. 

Q:  If you change a Shutterstock image to a completely different image do you still have 
to show attribution? 
A:  According to their license, yes. 

Q:  If use 20 different images from Shutterstock, in attribution do you name each one 
individually or just say “20 images used from  Shutterstock.” 
A:  According to their license, it says attribution for name of artist and Shutterstock, but 
I’ve seen it done without. Maybe in 6 pt type you put:  Images courtesy of…” and a list 
of all artists names. 
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Q: Trackpad or Magic mouse on iMac? 
A:  Don’t have trackpad but Wacom tablet. 

Q:  What is vector? 
A:  Two types of images, pixels/raster image and vector. Raster images are made up of 
tiny squares of color and when you blow it up the little squares or pixels show. The 
scaling or edit-ability of raster images is based solely on the resolution of the pixels. 
Vectors are based on mathematical expression where everything is portrayed in curves 
rather than pixels. Because of the curves, the image can be enlarged or reduced as 
much as you want and it never loses sharpness. Each of the curves is always editiable. 

Q:  Recommend we obtain both Photoshop and Illustrator if just starting out? 
A:  Get Photoshop at $10/month and use Inkscape as alternative to Illustrator, 
especially if all you are going to do is Image Trace in Illustrator. 

Q:  Why preference for Photoshop over Painter and others? 
A:  Adobe products are superior and Painter’s function is totally different 

Q:  What should we put into search on Shutterstock to get best results? 
A:  Stick to vectors and search for “pattern line art” or “pattern black and white.”  If find 
image you like, you can look at mages from the same artist. 

Q:  Do older versions of Photoshop and Illustrator do the same effects 
A:  Some of them, but some features are only in newer versions 

Q:  Suggest using a different form and use only jpeg in final save because jpeg 
degrades with every save? 
A:  True, but most people would never be able to tell 

Q:  Licensing for sites other than Shutterstock? 
A:  You just have to read their licenses. Each one is different. 

Q:  How do stock sites know I am using stolen images? 
A:   They do regular searches just like Amazon does 

Q:  Is there a way to pour pattern into an area? 
A:  Not “pour” in the sense of bucket fill but you can use clipping paths and similar to fill 

Q:  $200 to get 750 images on your computer and they are yours to use forever? 
A:  No. They are single use, but why would you be putting the same image in more than 
one coloring book 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Session 4:  DESIGN AND PUBLISHING 
Print on Demand (POD) is the quickest way to get your book printed and on the market. 
You have two primary options:  IngramSpark/Lightning Source and Amazon’s 
CreateSpace. Regardless of which printer you choose, when it comes to the publishing 
your book, there are some key considerations you must address: 

1. Page size and resolution are important. There are a number of popular sizes 
like  8 x 8 square, 8.5 x 11 and  8 x 10, and your choice is dictated at least in part 
by the type of illustrations you are making. For example, mandalas are circular so 
a square page makes sense. You can certainly use a rectangular page size, but if 
you do, you may want to add other elements, illustration or text, around the 
mandala to cover that extra space. Whichever size you choose, using industry 
standard page sizes makes it possible for you to get expanded distribution when 
using CreateSpace. Otherwise, options are limited. You will find the CreateSpace 
standard page sizes at https://www.createspace.com > books > publish a trade 
paperback. 

2. ISBN. To sell your book, you must have an ISBN for it. This is the global standard 
for identifying titles. It is how any store identifies your book as unique to you, and 
most retailers use the ISBN to track book inventory. Without one, your book may 
never be identified in the sales system nor be found for purchase. 

If publishing through CreateSpace, you will have multiple options:   

1) Free — CreateSpace owns the ISBN and is listed as publisher; 

2) $10 — CreateSpace owns the ISBN, and while you are listed as publisher in 
whatever way you want, you still cannot market your book outside Amazon; 

3) $99 — you own the ISBN and have control to do whatever you want with it   

IngramSpark requires you to purchase your own. This can be done from a company 
called Bowker at the website www.myidentifer.com.  

EACH version of a book, print, audio or eBook, requires its own unique ISBN. To 
maximize your investment, plan ahead and make sure to purchase enough to meet your 
needs.  

You can purchase ISBNs individually or in blocks. The cost per number can reduce 
rather dramatically the more you purchase at a time. For example, a single ISBN is 
$125 while a block of 10 is $295 bringing the price per ISBN to $29.50. A block of 100 is 
$575 for a per unit price of $5.75.  

When you purchase a block, your account will look like the image below. You will get a 
list of ISBNs, and you just work your way down the list using each to assign a book title 
to it as you need a new ISBN.  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RECOMMENDATION:  If you are just getting started, go with the free or $10 option from 
CreateSpace. If your book takes off and you want control, buy your own ISBN and re-
publish your coloring book. If you want to do this in a very serious way, do yourself a 
favor and purchase your own ISBN.  

If you think you will publish more than one book or in more than one format, purchase a 
block because purchasing individually can get very expensive. Set up an account with 
MyIdentifers.  They run specials all the time so you can pick up a block at a 10-15% 
discount.  

It is a straightforward 
process. Once you assign a 
number to a title, you simply 
provide all the title, 
contributor, format & size, 
and pricing details for the 
book assigned to that ISBN, 
and upload a .pdf of the text 
and a cover image to 
associate with that title for 
reference.  Once completed, 
this information will go onto 
a list that is distributed to 
libraries, book stores and 
any other retailer outlets 
selling books. 

With CreateSpace, it is 
generally the same 
information (title, ISBN, 
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description, author info, etc.) built into the process, either the guided process or expert 
process.  

DESIGNING YOUR BOOK

Design comes down to interior and the cover. For interior, it is best to use page layout 
software like Adobe InDesign. You can also use web-based app like canva.com. Cover 
design is created in Photoshop or similar. Canva doesn’t have templates for covers and 
is not suitable for the cover design.  

INTERIOR

In addition to your actual coloring pages (page count should be in increments of 4 or 8 
is better) you will need: 

• Title Page 

• Copyright page:  always back side of title page (see image below) 
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Optional: 

In the front of the book: 

• Instructions (on how to use the book):  information like what pens/pencils to use, 
color theory and selecting colors, how to use coloring in relation to journaling if using 
a journaling element, etc. 

• About this Guide:  inspiration behind why you created the book, focus of your choice 
of niche, reason for doing like making money for non-profit, etc. May be one or more 
pages. 

• Dedication 

In the back of the book: 

• About the Author/Illustrator:  usually located in back of book, including a brief bio 
with or without a photo 

• Ads:  can be a wise addition, especially if you are planning to do additional books. 
Even if books are not completed yet, a it can be very beneficial to include a 
statement that says “Coming soon from [author name]…” 

• Web site address or Facebook contact information where you can interact with 
people. You may want to offer additional pages related to this book as free 
downloads from an identified web site which is linked to an opt-in page. For 
example, “for additional coloring pages related to this book, you can download them 
for free at www.yourwebsite.com”. 
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DEMONSTRATION:  Laying out a sample book 

For this exercise, we will use canva.com:   

1. log on — you will need to sign up for a [free] account 

2. Use custom dimensions 
(right image) and put in 
the size of the book you 
want to create, in this 
case 8 x 8 > Design  

3. Upload all your page 
images, any support 
images, and text. All 
images must be 300 ppi 
at a final size to fit the 
page of 8 x 8. NOTE:  
this process can be 
easier if you put all the 
images and text files for 
a specific title into a 
single folder on your 
hard drive, making them 
easier to locate when 
you start to upload your assets.  

4. Create Title Page. 
Canva has numerous 
layout options (see 
image right) or you can 
just add text yourself.  

Type text for title and 
sub-title (if using), 
choose from among 
multiple type face 
options, reposition text 
(left mouse click and 
drag), add author name 
(do not use the word “by” 
as in “by Tony Laidig”) > 
add an image if you want 
by selecting one from your uploads > resize image, text, etc. and reposition as 
necessary to center all the content on the page. 
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5. Click the button below the working canvas that says “+Add a new page” and create 
copyright page (text below) plus any other optional pages you want to include. 
Again, adjust the position, font, text attributes, etc. of the text to suit you. 
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6. Add New Page for Dedication. Include any 
decorative design elements you might want 
to have on a page.  

7. Add New Page to start coloring book images. 
In publishing books, new chapters always 
start on the right hand — odd page number 
— side. For a coloring book, all image pages 
should be on right hand pages with blanks on 
the left/even page numbers. You can number 
your pages, but you don’t have to. Leading off 
with the Alice In Wonderland Image, click 
image in your uploaded assets > adjust to fit 
on page. NOTE:  if we wanted the images to 
bleed to the edge of the page, it would have 
been necessary to create a page size of 8.25 x 8.25. That was not done here, so the 

images will have a white border around them on 
the page. Just by clicking on the image, it will 
insert it with a slight indent. Canva is resizing the 
image slightly, but is not taking away from the 
resolution of the image. 

8.  Add new page > leave blank since this is the 
left side page. If you want to add text like a 
quotation related to the image or inspiration 
phrase, etc., you could add it on the left hand 
page opposite an illustration. For example,  see 
image below. NOTE:  if you want to make sure 
your quotes are hitting in the same exact place 
on every page, simply duplicate a quote page 
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using the double page icon to the right of the page canvas and move it to a new 
location using the arrow icon. Then change the quote text. 

9. Continue adding pages, blank or quotes on even numbers and coloring images on 
odd number pages until the book is completed. Add whatever pages are necessary 
to have the total divisible by 4 or 8 including your optional pages (guide, About 
Author, etc.). It is a straight-forward and not difficult process. 

10. When all pages are laid out, click “Download” and download as high-quality .pdf. If 
you use none of their premium elements, there is no cost. Check the document in 
your pdf reader and save where you can easily find the file. 

BOOK COVER

The cover is a little more complex and takes a bit more effort to do the design. In 
addition to the page size itself, there are very specific calculations you must account for 
in the size of your cover layout.  

Bleed:  Most books have bleed where the cover image runs off the edge, allowing for 
trimming the paper so that the image will be edge to edge in the final cover design (as 
opposed to having a white box around the cover image. So, you have to account for that 
bleed in calculating the size of the cover layout. Standard print bleed is 1/8 inch or .125.  

Spine:  the spine is calculated based on the number of pages and paper weight. Both 
IngramSpark, an on-demand book printing/distribution service and CreateSpace, 
Amazon’s on-demand service, have calculators where you will enter details to get the 
spine size if printing at one of those services. 

To use the Ingram calculator [https://lightningsource.com/spinecalc.aspx], you complete 
information on the trim size, in this case  8 x 10; paper choice, binding type, laminate, 
whether you are using duplexing (printing on both sides of the paper), and the page 
count. In our sample book, we will enter 96 pages. The result is a spine size of .199. 

The calculation at CreateSpace is slightly different. For white paper, you simply multiply 
the page count by 0.002252 (thickness of one sheet of paper). In this case, because 
CreateSpace uses a slightly heavier paper weight than IngramSpark, the spine size is .
22 (but IngramSpark uses 50lb opaque paper which is less see through than 
CreateSpace Paper.) 

The formulas for calculating the width and height size are:  

Width = Bleed + Back Cover Trim Size + Spine Width + Front Cover Trim Size + Bleed 

.125 + 8 + .22 + 8 + .125 = 16.47” 

Height:  Bleed + Trim Size + Bleed 

.125 + 10 + .125 = 10.25” 
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So, to lay out a cover for 8 x 10 book in Photoshop or another software option, you 
would create a canvas of 16.47 inches x 10.25 inches 

With all the necessary information, both printers offer templates you can use for creating 
your cover 

Ingram:  www.lightningsource.com > file creation > cover template generator 

https://www.createspace.com > books > publish a trade paperback > cover. Here you 
can use the CreateSpace Cover Creator to select one of their designs and quickly 
create your cover or build your own cover to meet the specifications found here.  
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DEMONSTRATION:  Book Cover for 8 x 8 sample book using Adobe® Photoshop 

1. Open Photoshop > create new file, 16.47 inches wide x 8.25 inches high, 300 pixels/
inch 

2. From ruler bar, click left mouse button and hold while dragging out both vertical and 
horizontal center guide lines 

3. Identify and mark the spine:  open the info panel to view the 
details of what you are about to do and then with the 
rectangular marquee tool selected, draw a rectangle .22 
inches wide x any height. The info panel will show you the 
width of the area you select so you can get as close to .22 as 
possible; drag the selection to the guideline and snap it to the 
center (image left side at right). Pull guidelines to each side of 
the marquee box (image right side at right). You now have marked the 
location and exact measurement of the spine in your cover. 

4. Draw guides for the .125 inch bleed  on all sides of the document. HINT:  you can 
draw a 0.125 inch marquee and move it to the edges before drawing your guide the 
same as you did in step 3. This will help you to get the guides in the correct place 
without having to do the math. ;) 

5. Select the image you are going to use for the front cover, flatten it, and import it into 
the new file for your cover; scale image to snap to the bleed guides and drag into 
place. 

6. Now, design the cover. On the front cover, you will need a place for your title and 
possibly sub-title as well as the author name. Type these, select the size and type 
font/style you want to use and put these elements in place on the cover. Make sure 
any type or live copy is at least .25 inch from the trim edge (the bleed guides you 
pulled out in step 4).  

7. You will probably also want to add color since this is a coloring book. Create a new 
layer for coloring, set the blend mode to “multiply” and choose whatever color you 
want to paint; select a brush and adjust its size, and color the areas you want to 
colorize. You can create a new layer for each individual color or color all on one 
layer, however you prefer. You may want to colorize the entire image, but you may 
also want to show it as a work in progress instead. it is your cover and your choice. 
Your text is editable and can easily be colored as well. When choosing colors, keep 
in mind that you want to select colors that are complementary and similar tonally. 
You want things to match and be visually appealing.  

8. Spine:  it is fairly small. You can choose to try to put the title and author name on it 
or not. NOTE  if the spine is too small, CreateSpace will not allow text on it. 
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9. Back cover:  regardless of where you are publishing, you must allow space in the 
lower right hand side of the back cover for your ISBN and barcode. You can also 
include a publishing company name/address/web site, etc. on the lower left side of 
the back cover if you want. You can also choose to include some back cover copy 
like reviews or additional related images, etc. to fill the back cover. With coloring 
books, back cover copy is totally subjective. Look at some of the coloring books out 
there and then be creative. 

NOTE:  For retail sale, your book will need a barcode or UPC code. If printing through 
IngramSpark, you will need to create the barcode for insertion into your layout; if using 
CreateSpace, the barcode will be added automatically via the CreateSpace system. You 
can find an online barcode generator at http://bookow.com/resources.php where you 
can easily generate a barcode from your ISBN and download a .pdf or .png file. You 
don’t need to include a price but if you do, the secondary bar code controls the price 

10. When finished, save the Photoshop file. Then flatten and save as Photoshop PDF 
which will…  Your cover might look something like the following:  
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Now you have a completed cover and interior pages designed. It is time to upload and 
publish. 

PRINTING YOUR BOOK

As stated earlier, Print on Demand (POD) is the quickest way to get your book to 
market. You can shop around for a traditional printer, but it is not as easy, and a 
traditional printer or publisher is going to cost you significant money up-front. In addition 
to your two primary POD options, IngramSpark and CreateSpace, there are other 
options like Lulu or Blurb which tend to be more expensive. The question is, which are 
you going to use?  There are benefits to each. 

Paper type 

When it comes to coloring books, bleed through is an issue. IngramSpark uses a 50 
pound opaque paper which is slightly thinner than the paper used by CreateSpace, but 
it is more dense leaving no bleed through. IngramSpark also has a heavier 70# option 
called “Standard Color” in their color publishing. This is the paper a lot of high end 
coloring books are printed on, but it will cost you more per book. IngramSpark’s 50 lb 
opaque paper ultimately looks and colors better than the paper from CreateSpace. 
When it comes to perforated pages, you are not going to get perforations out of on-
demand printers without some hefty costs, if at all. 

RECOMMENDATION:  If you are just starting out, print through either IngramSpark or 
CreateSpace. If your book takes off, re-publish using a traditional printer. Your cost per 
unit will be less and you can sell on Amazon through FBA.  

DEMONSTRATION:  Uploading to CreateSpace 

1. Log into your CreateSpace Account (free to sign up) > Add a New Title 

2. Complete the 
requested information 
to start > Get Started. 
Using the guided set-
up process is 
recommended until 
you’ve done it a few 
times. it will be easier. 

3. You have quite a few 
options in the drop-
down list for 
contributors. Add 
yourself as both 
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author and illustrator. From a marketing perspective, you want people to know you 
are illustrator so you need to brand that way. If book is part of a series, check the 
box and provide series title and volume number for this title. At this time, you can 
complete the publication date or come back to it at a later time. 
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4. ISBN:  this is where you have the ISBN choices discussed previously > Assign 

5. Complete details about the interior of the book. In this case, they only have 8.25 x 
8.25 as industry standard size. For the demo, we will create a custom size of 8 x 8 
on white paper. 
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Once you select the interior pages file from your computer for upload, check to have 
their Interior Reviewer run a check on formatting and print issues. It will process and 
then report back to you any problems found so you can correct and upload a corrected 
version. 

6. While you wait for review, work on the cover. The only accepted format is .pdf. 
Locate the file on your computer, select your cover stock > Save 
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7. Address any issues found by the Interior Reviewer or ignore and save. You will then 
get a basic review of your book specs. You can edit each of the individual items and 
when finished, submit your files for review. Amazon goes through  the review and 
prepares the file for publication. 

8. Choose Distribution Channels > amazon.com > Save   
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9. Establish your Amazon list price > calculate. Based on a list price in this demo of 
$14.99, the royalties paid to the publisher will be $4.49 per book. 

10. Choose “Description” next. This is where you put in a description of your book and 
additional relevant information. Bisac Category is generally the category/sub-
category where your book should appear. 
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Once all this is completed, everything for the book is all set up. It just has to be 
uploaded for review. After review is complete, you can order a print copy to take a look 
and make sure all is correct before going live. Once you sign off on it, it can go live. 

The process for uploading to IngramSpark is very similar. Once you set up your 
account, you will add a new title and complete the information the same way as in the 
CreateSpace setup. The web site is detailed and gives specific information on what is 
required for each data field.  

Make sure for a coloring book that you only set up your Product Type for “Print Only” 
because the default setting is “print and Ebook,” but you will not do Ebook for coloring.   

One area that will be different with IngramSpark is Pricing. Once you establish a price, 
in this case $14.99, you will set the “Wholesale Discount” to “55% trade” and the 
“Returnable” to “yes.” If you set Returnable to “no,” bookstores will not buy. If you set the 
discount for less, bookstores will not buy. It is as simple as that.   

Once all the information is completed, you will upload the 
interior file and cover by uploading or drag & drop. Once 
the files are uploaded, it goes through a two step 
validation process. After approval is given, you can 
purchase a review copy > confirm and publish. 
IngramSpark will automatically distribute to Amazon so 
your book will be available there and it will make your 
book available for distribution to other bookstores as well. 

Take your time and complete the information carefully. It is 
a simple and straightforward process.  
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Session Q & A 

Q:  Insights on Pricing 
A:  go to Amazon and see what everyone else is charging. It is the best way to evaluate 
the market and competition by drawing conclusions from what is already listed and 
selling. In coloring books, the page count has a lot to do with the price. It is okay to price 
slightly higher because it gives you room for offering a discount.  

Q:  ISBN 
A:  Check your country to find the rules and pricing for ISBNs. It isn’t all the same. For 
example, in Canada, ISBN is free if you meet requirements. 

Q:  Mini books? 
A:   mypublisher.com   3.5” x 2.75”, 20 pages for $2.99  Sometimes they run a big sale 
and that is the time to buy many of these ;) 

Q:  Canva for everything? 
A:  if doing regular book, allow for gutter margin:  3/4” inside and 5/8” on outside edge 
so have to vary pages back and forth 

Q: Color printing on inside cover 
A: Not on CreateSpace.  Possible with IngramSpark, but costs more to add color 

Q: Should you reference that you are using PD images? 
A: There is no need to and it is nobody’s business 

Q: Can do bleed on coloring pages? 
A:  Yes or you can put frame around it. Sky is the limit 

Q: Industry standard for bar code placement? 
A: more or less; 1/2” from bottom and spine edge; both POD printers have it on their 
site where it should be and their templates include it also 

Q: have to pay for font license? 
A: No. Paid when purchased font 

Q: Good idea to put “coloring book” or “coloring book for adults” on cover 
A: Look at the competition on Amazon. They do so okay to do it. 

Q: Can publish on both CreateSpace and IngramSpark? 
A:  Need to pick just one 
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Q: Does barcode come with ISBN? 
A: Yes if buy from CreateSpace; no if buy your own through Bowker. They do give you 
option to buy one, but it is unnecessary if you go to web site referenced here and make 
one at no charge. 

Q: Why use CreateSpace if IngramSpark is better quality? 
A: Best reason (not a good one) is that because IngramSpark is competitor, AZ will 
often show your book is “available but takes two extra days to process.”  It’s Amazon’s 
ball and bat. Prefer IS for coloring books because paper is better. Another advantage of 
CreateSpace, though it is not a significant advantage, is that if you publish through 
IngramSpark, the “Look Inside” feature is not automatic. You have to go in to your 
Author Central account and upload a .pdf to get this feature. 

Q: if republish, doesn’t change ISBN and you lose all your reviews, etc. associated with 
original 
A: Yes. You can re-publish as “updated version” 

Q: if illustration fills the page, doesn’t it make it difficult to color near the spine 
A:  lay flat is very expensive to incorporate into coloring book. Encourage them from the 
front of the book to rip up the book. Be upfront and you will stop some of the 
complaining. All the books are done with saddle stitch (lower paper count) or perfect 
bound paperback, so… 

Q: Coloring book in Ebook format? 
A: No. No to pdf and anything downloadable. Don’t give away your illustrations 

Q: IngramSpark have set up fees? 
A: Yes.  

Q: as author, do you get to buy your book at discount? 
A: Yes. List - your royalty 

Q: IngramSpark use saddle stitch? 
A: They give you a choice based on page count 

Q: Can use QR code instead of bar code? 
A: No. Must have bar code. You can include QR code and is great idea, but must have 
bar code 

Q: acid-free paper? 
A:  traditional printing. If one of POD does it, you have a better chance with 
IngramSpark 
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Q: what page count should start being concerned with gutter margins 
A: if perfect bound, right from the start; otherwise, when pass 48 pages 

Q: cost to print with IngramSpark? 
A: slightly higher (maybe 10%) but quality warrants it 

Q: Amazon paper choices? 
A: White or cream. 

Q: What is necessary to re-publish. 
A: Request to Amazon to “retire” title; once retired they pull it from their system and you 
can republish with different ISBN 

Q: can group of people share block of ISBN 
A: No 
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Session 5:  MARKETING 
This session features a guest presenter joining with Tony Laidig. Kristen Joy, known as 
The Book Ninja, is a multi-best-selling author, award winning blogger and book 
marketing specialist who is currently selling her first coloring book on Amazon and has 
her second book in the works. 

Once you have your coloring book finished how do you market it?   

There are a lot of myths surrounding the marketing of books, and this is a good time to 
discuss some of those. 

1. “I am going to make a million dollars.”  There are authors who do this with their book 
or book series, but that is not the norm and it is certainly not the norm for a self-
published author. It is very likely not going to be the case for you. 

2. “Everyone will want to buy a copy of my book.”  Regardless of whether fiction or 
non-fiction, we put a lot of time and effort into our books. It is understandable that 
we would love it and feel attached and even not understand why anyone wouldn’t 
appreciate it. The reality is not everyone is going to like your book, find it interesting 
or want to purchase it. It is best to try to remain unattached to outcomes. Do ALL 
you can to make your book a success but whatever happens at the end of the day 
has to be okay with you. 

3. “My book will open up LOTS of opportunities for me.”  While this can happen and 
has, the truth is in most cases, it won’t 

4. “My book speaks for itself.”  One huge mistake you can make in marketing anything 
is assuming that your audience can automatically read your mind and understand 
what you are trying to convey. In your marketing, promotion, sales copy, web site, 
and even in the book itself, you have to dumb things down to the level of a 5th 
grader. Be very clear and concise. It isn’t that everyone is stupid, though they 
certainly can be, but even smart people are busy and distracted and don’t read 
instructions or pay attention. 

5. “My legion of fans is going to market my book for me.”  While you may get referrals 
and people will tell their friends and family about your book, you cannot count on 
that happening. You have to market your book because no one else is going to do it 
for you. You are the one who created it, so you are going to be the one who is most 
enthusiastic, most excited and in the best position to get other people enthusiastic 
and excited about it. That is what marketing is about:  getting others to feel the 
excitement you have about your book so that they want to buy it. 

You MUST market your own book HEAVILY and make sales happen on an 
ongoing basis. It is your job as the author to market your own book! 
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STRATEGIES FOR MARKETING YOUR BOOK

All the tactics in the world will be worthless unless you have a plan. You need to be very 
strategic about what you do and when. Don’t make it harder than it needs to be. Don’t 
get overwhelmed thinking you have to do everything. But set your calendar down and 
schedule it out over three months. Add something every month or if possible for you 
every couple of weeks, continuing with the previous tactic(s) until you have several 
marketing strategies working in your favor at once. Don’t overcomplicate it but 
Consistent Intentional Action is key. 

Marketing Your Book:  A Dozen Strategies  

1. Author Central (see sample below): this is the author’s “home” on Amazon and is 

provided free to every author who has an ISBN and lists his/her book(s) on Amazon. 
It is important and should be included in your plans. It is not difficult to set up, but 
you cannot set up an Author Central Account until you have a book published and 
available on Amazon. Once you set up an account, this is an important place for you 
to include: 

• Photo and Bio 

• Books:  listings of your published books (provided by Amazon). If 
you’ve co-authored or illustrated a book and it doesn’t 
automatically show up, you can add these with a simple click of a button 
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• Blogs: when you post an update to your blog, the blog teasers that appear on the 
Author page will update automatically 

• Events that you are having like a local book signing 

• Videos:  Be creative. For example,  you might shoot video of you talking about your 
inspiration for creation of book — great to do during a book signing in a book store 
— or an interview you’ve done where you talk about your coloring book or illustration 
style, etc. 

• Book trailer for your book [If you need help, training on how to do book trailers is 
available at www.easybooktrailers.com] 

• Twitter Feeds:  the ability to add your Twitter feed is a terrific feature. This gives you 
the ability to post links to your training courses, books, feeds, etc. right here within 
Amazon.  

Amazon provides you a URL to share your Author page on Facebook, Twitter, etc. For 
details on how to set up a page, if you haven’t done so before, go to 
authorcentral.amazon.com. You will find a detailed explanation on all details of the 
Author Page 

2. Pre-Selling:  this is a huge marketing 
strategy. Kristen sold almost 100 copies 
of her new coloring book before it was 
published just by posting it on Facebook 
and emailing to her list three times. Her 
profit was about $1,000.  

Why presell?  A lot of people think it is “to 
make money,” and while that is certainly 
nice, the real reason is to get the social 
media buzz going, to get people posting 
photos, hash tagging, sharing and talking 
about the book before you launch.  It is 
also a great way to test your product, get 
feedback and analyze some sales data 
that can help you in preparing your 
launch.  

What do you need?   

• A simple website (Wordpress, Wix, 
etc.), somewhere to put up a web page 
with a very simple Paypal set-up 

• PayPal Buy Button:  just log into your 
PayPal account > merchant settings 
and follow their instructions to get the 
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short code to copy/paste into your web site. 

• A new page with title, cover image, book description and BUY button (see image 
above) 

• Optional:  you can include some interior images of what your illustrations look like 

• Optional:  Free Shipping. Amazon has it for Prime members and for more than $25 
orders, so why shouldn’t you do it. Yes, you will eat these costs at a rate of $3-7 
per book, but it is up to you to determine if this cost is worth it to you to build buzz. 
Should you ship overseas?  It is going to cost you and may be more than the sale 
of the book, but it may be the best chance you have for building buzz overseas, so 
you have to consider it. 

Make it clear on this pre-sell page that you are selling an autographed copy. It is 
extra motivation for people to buy. You cannot do it on Amazon, and it is a good 
selling feature because it personalizes it for your buyer. This plus free shipping are 
HUGE selling points.  

3. Facebook Fan Page:  Fan pages and groups give your fans a way to interact with 
you on a different level, and if they are active, they can be quite engaging, 

4. Facebook Groups:  these encourage members to participate with each other 
creating a sense of belonging. Your fans can get support from other members or 
share their experiences with your book or product. With a coloring book in particular, 
this can be a great place you can point customers to where they can share images 
of your pages that they color and show off how they look. 

5. Amazon Giveaway:  Amazon has a giveaway feature built into the site, and this can 
be a great strategy to increase interest and sales in your coloring book. It is simple 
to set up (see demonstration below) and it doesn’t have to be your coloring book 
that you give away. It can be someone else’s book or another physical (not digital) 
product on Amazon. You choose how many (or how few) books or other items (e.g. 
pens) to give away, but you have to pay up-front full retail plus shipping for every 
product you are giving away, including your own book. Once your giveaway is live — 
which seems to take about 1-2 hours — you can share your link everywhere. NOTE:   
Giveaways are country specific. Check to see if your country has a giveaway 
program on Amazon. 

6. Social Media Buzz:  this is really important. It is absolutely vital that you get the 
word out about your coloring book on a consistent, regular basis, even before it is 
published. Chances are most people are on either Facebook, Twitter, Instagram, 
Pinterest, or other social sites and you want conversations in these places about 
your book. Seed things on your Facebook timeline, in tweets, in other posts, etc. 
weeks and even months before the book is released. By doing this you build 
excitement and buzz about your book to help it take off when you launch. You might 
be surprised to find people are posting messages about your book and helping you 
to build excitement before you even launch the book. 

© Copyright 2015 Tony Laidig Page !  of !78 91



Coloring Book Master Class Tony Laidig

7. List-Building: you should be considering building a list regardless of what you are 
selling. It is always important to have a list-building strategy built into your marketing 
plan. For example, you could have a page in the back of your book with website link 
where people could go to download additional coloring book pages. In exchange for 
those pages, they have to put themselves on your list with name and email address. 
It is a simple way to build a list. 

8. Book Reviews:  reviews are very important on Amazon. According to Kristen, it is a 
MYTH that more reviews is better. A lot of people think they need 100s of reviews to 
get attention and rank on Amazon. It is more important to get good reviews, 4-5 star 
reviews!!  Three-star reviews are terrible because 9 out of 10 times, people are just 
saying “the book was okay” and not really giving a review to be doing it. Too many 
five star reviews doesn’t look credible so 4 star reviews are fantastic. More reviews 
isn’t better; more quality reviews is better. Shoot for 20-30 good reviews. Once you 
reach this point, all people will look at is the number of stars. They will never read 
that many reviews.  

Where do you find reviewers?   

• Topic-based Facebook groups. Don’t discount the power of this. There is a list of 
Facebook groups devoted to coloring!  Do not try to spam these groups. Some of 
them are groups for the sole purpose of coloring pages from a specific book. Read 
the description of the group before you join in with a discussion about your book. 
Doing that in a group that is dedicated to the work of a single author is not 
appropriate. But if you are excited about coloring (and you should be if you are 
creating a coloring book!) then you should want to join groups of people with a 
similar interest and join in discussions about coloring. Tell the other members you 
are a coloring book author and are very excited about coloring. List some of your 
other favorite coloring books. The topic will get going about your book, and it will 
give you the perfect opportunity to say “I would love for you to check out my book 
and if anyone buys it, would you please leave me a review.” You need to interact 
with the other group members as a participant, not just as someone trying to sell 
books, and the more you do, the more books you will sell. 

• Other social media groups:  for example, self-help (because these coloring books 
are good therapy), are great places to post 

• Email opt-in:  put up a simple opt-in form on your web site offering free .pdf review/
advanced copy of book if they “sign up here.”  The automated system adds people 
to your list and on the “thank you” page you can either set it up so they can 
download the copy or you can automate an email response to send it to them. An 
auto responder attached to this can remind them to post their review on Amazon. 
Once your book is live on Amazon, change this to a link to the page on Amazon 
where they can post their review of your book. 

• Friends and family — post information about your book everywhere. Post it all over 
your social media.  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• Advance reviews from pre-sales by including a simple review request card inside 
the book when shipping:  An example of Kristen’s follow-up card can be seen 
below. It is a simple two-sided card, printed 4 up on 8.5 x 11 paper and inserted 
into each coloring book sold. The front has an image of the book cover. The back 

expresses the difficulty for an author in getting reviews and asks for a review from 
the buyer. The URL of KristenOnAmazon.com is a short link to her Amazon Author 
Central page. You may not get a lot of reviews from this, but you are sending 
people to your Author page on Amazon where they will see all your other books 
and may purchase more of your books. The addition of the support email is a great 
idea as well because you might get requests for bulk sales for writers’ groups.  

Note how this card is designed as a real marketing tool. Addresses for Kristen’s 
social media pages and web site are included. Why does this work for her?  
Because hers is a coloring book and journal for writers. Writers. Writers who are 
interested in her coloring book might also need other types of goods and services 
she offers related to writing. 

• Blogs:  Research related blogs, contact the bloggers and offer to send an advance 
copy before the book is published and even after it is published. Send a free copy 
in the mail in exchange for a review on their blog. Include a letter with the book, 
hand-written is best — and ask the blogger to copy their review over to Amazon. If 
you really want to market through these bloggers, also send a package of high-end 
Prismacolor pencils and/or their favorite snack (if you don’t know this, chocolate 
almost always works) along with the book. 

• Include a page inside your coloring book asking for honest reviews 
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• Follow up with your people on social media. In those Facebook groups where you 
are participating, make a post to say, “Hey, guys… just wanted to let you know my 
book is out” and when someone says they got it, tag them, thank them and ask 
them for their honest review. Include a link where they can go to leave a review. 
Do this any time you find where someone has posted about the book. This gives 
them the link so they don’t have to go hunt for it and it gives the link to everyone 
else so they know where to buy the book. TIP:  There are web sites that track 
hashtags in social media. Use a hashtag related to your book when you talk about 
it so you can track it. You cannot be on social media all the time, so this is a good 
way to keep track of talk about your book. Use alerts (e.g.Google alerts) that are 
constantly searching for specific phrases and send you a daily report on those 
being used across the web. It is a great way to keep track of who is saying what 
and where. 

Two key things to remember 
1. You have to ASK!!  People don’t do things they aren’t told or asked to do. If 
you don’t ask, most people are not going to do it. If you post an 
announcement on Facebook, you have to say “Please share this with your 
friends.”  Your share rate will greatly improve. 

2. Follow up with people who have agreed to read your book. If you ask people 
to review your book, keep track of them and follow up.   

9. Bookstore Signings:  This is not for everyone. Some people may be excited to do 
these while others wouldn’t consider it. The biggest hurdle is meeting the 
bookstore’s requirements. Expanded distribution is not enough. You must list your 
book with a 55% discount and as “returnable” which is not allowed on CreateSpace. 
Your book has to be priced at a similar price point to other similar books on the 
market. You must have an ISBN registered to you as a publisher, not as an author 
name or book title name. It must look like a publisher published the book, but the 
bookstore does NOT have to know you own the publishing company. If you can 
jump through the hoops and meet their requirements, coloring books are big in all 
the bookstores these days, so this type of book is a great opportunity for you to do a 
bookstore event. If you are a local author with a coloring book, you are going to be a 
“celebrity.”  Go into the local store with a copy of your book and ask to speak with 
the events specialist. Bookstores large and small have someone in charge of 
events. Barnes and Noble actually has in their center kiosk an event planner. Talk to 
that person. They will look the book up in the system and if it meets their 
requirements, they will usually pre-order 10-20 copies to keep in the back. You can 
have people go into the store in advance and request the book because they will 
pull it from this stock in the back. Events are another good way to get media 
attention, too. TIP:  if you sell a mere 6 copies of your book during a signing, the 
stores will think you are a hit and will likely also stock your book and ask you to 
appear again.  
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10. Non-Bookstore Retail: gift stores, mom and pop shops, doctors’ offices, counseling 
centers, etc. Don’t be afraid to ask. The worst they can do is say “No” and you 
should not take this personally. You haven’t lost anything and it isn’t personal. 
Besides, what if they say “Yes.”  Kristen has even done a signing of ‘How to Save 
Money’ books in a high-end art gallery, one of the last places you might have 
expected to see such books having a market! 

11. Craft Shows/Festivals/Fairs:  these can work great. They are everywhere, happen 
about every weekend during the summer and during the holidays which is great if 
you are doing a holiday themed coloring book. Think about local health fairs. These 
coloring books are supposed to be therapeutic — stress relief — so it makes sense 
that you would be selling them at a health fair. 

If you are doing a themed coloring book, you have to plan 3-6 months in 
advance of the holiday. If you want to do a Christmas coloring book, you need 
to be designing the book in August/September at the latest, not December. 

12. Charity Support:  offer to give a portion of the proceeds from a coloring book to 
support a charity. This can be especially appealing if your book has a theme related 
to the mission of the charity. For example, if your book is illustrations of dogs, a local 
pet shelter is a perfect place to offer charity support from sales of the book. People 
always want to support charity so there is a built-in customer base you can reach 
out to; your coloring book is getting increased exposure and getting into more 
people’s hands; you are supporting a charity; and maybe you are even making a 
couple of bucks for yourself. You can sell a lot of books using this method. TIP:  In 
all your promotions and in the book, you want to use the wording “A portion of these 
proceeds go to XYZ charity.”  

DEMONSTRATION:  How to set up an Amazon Giveaway 
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1. Search Amazon:  “Prismacolor pencils,” an appropriate complementary product to 
use as a giveaway for promoting a coloring book  

2. On the page for the item you want to use (in this case, Prismacolor pencils 24 pack), 
scroll to the bottom of the page and below the reviews, you will see “Set up an 
Amazon Giveaway.” 

3. Click the button to set up a giveaway > complete the details of your giveaway. You 
can use  “Lucky Number,”  to give away a prize to every xx number of people who 
enter or “First-com, First-served” to give a prize to the first xx entrants. There are 
advantages to each as are outlined on the details page. In this demo, we will choose 
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“Lucky Number” and give a prize to every 13th entrant until 2 winners are selected. 
You see immediately how much this will cost you for the product plus possibly tax 
and shipping.  

4. You can require entrants to follow you on Twitter (so people will get your notifies 
when you post about your book), in which case, you will need to connect your 
Twitter ID, or require nothing more. You will see under the heading “Additional 
details” the information that is auto-determined by Amazon. This giveaway will 
expire in about a week, is only available to residents of the 50 states plus District of 
Columbia, and prizes will be shipped using standard shipping. 

5. Next, create the giveaway ad. You will need to follow Amazon’s rules — which 
include saying “a chance to win” as opposed to “win” — when creating your ad, but 
the ad is as simple as typing into the dialog boxes the words you wish to print. The 
sample ad to the right of the page shows where the text will appear when you click 
into a text box to type (see image below). The biggest challenge is creating your ad 
with a limited number of characters, but Twitter users will find it easier to do. 
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If you have a Twitter link in your account, Amazon will pull your photo and info right from 
Twitter. 

You can include a welcome message to entice people to enter. For example, “Hey 
Coloring Book fans…here is your chance to win one of the best sets of colored pencils 
on the planet! Good luck!   

You also determine the message shown when someone wins or loses. There are some 
cool things you can do with the win page. Amazon allows you to add links so you can 
link to a specific product like your coloring book page!  You might say, “Congratulations! 
You’re a winner. Love coloring books? Check out this one” and then include a bit.ly short 
link to your Amazon page (a short link is important because your characters are limited 
and bit.ly lets you track the clicks). 

You can do the same kind of thing for the lose page: “Sorry you didn’t win, but you may 
want this awesome coloring book” along with the short link.  

You have the option to remove share buttons from your giveaway to reduce the 
likelihood that participants will share your giveaway with their friends, but when you are 
promoting your book, that is probably not a good idea. In fact, it might never be a good 
idea. 

6. Proceed to checkout and pay for your product(s) > review your order > place your 
order. Your giveaway is set up and Amazon tells you to wait for your giveaway to go 
live ( a couple of hours) before promoting it. 

What does the giveaway look like?  Here is a sample (below left). When you click on the 
box, you find out the result (image right). NOTE:  you can only enter once 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Session Q & A 

Q:  Should you include Sales Tax? 
A:  Talk to an accountant 

Q:  Are iSBNs specific to coloring books or if I buy 10 can I use on different books 
A:  ISBNs are not coloring book specific. You can use numbers from a block on any kind 
of book at all, including Ebooks.  

Q:  Why did you choose the rabbit hole concept to do your coloring book 
A:  1) Huge fan of Alice in Wonderland; 2) this is the 150th year anniversary of that book 
so there will be a lot of additional press about it making it possible to ride the wave of 
promotion done by giants like Disney; and 3) sister has tea room and does themed 
parties which have been hugely successful — she will be doing The Mad Hatters Tea 
based on Alice in Wonderland in September and guess where this coloring book is 
going to be. Pay attention to what is going on in your areas of interest!  By doing this 
coloring book, it is possible to include marketing words like “created this 150th 
Anniversary coloring book based on Alice in Wonderland” in posts and promotions and 
even spend a couple bucks to get gold seals to put on the cover making it a limited 
edition. 

Q:  what should I include in coloring books to market other products/books I want to 
promote 
A:  One easy thing is to add a page in the back of your book that lists all the other books 
you’ve written, especially if related to topic of your coloring book or niche 

Q:  what are pain points we are solving for people to make sales happen? 

A:  with a coloring book specifically, the driving mechanism behind why these are so 
popular is therapy aspect, great de-stresser, great way to relax… it has been shown that 
people who color tend to relax more. You are creating a book for this market, not just 
throwing coloring pages up there. Kristen’s book hits three main points:  it is not only a 
coloring book for relaxation but it is also a journal for writers with writing prompts and 
includes motivational quotes. Each of these hits specific pain points for writers and each 
can be specifically called out in descriptions of the book to elicit a reaction from a writer  

Q:  Are these marketing strategies universal and will apply to any kind of book we 
publish 
A:  Yes. The training was based on method so it can be applied in many different 
situations 

Q:  How many sales is it reasonable to expect? 
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A:  Zero. That is why you have to concern yourself with the content, cover design and 
marketing. There are many variables that can factor into good or bad sales. It is totally 
up to you. Some horrible looking books sell like crazy while some gorgeous books sell 
nothing. What is the difference?  The author of one marketed the daylights out of it. 

Q:  In Real Fast Kindle Comics you taught to render our pages for children’s books 
using ComicLife. Can we use Comic Life rather than Canva for layout? 
A: Yes. It will work. It might not be as good as a program like InDesign, but it has some 
great tools in it and there are some instances where it could be a great idea to use 
ComicLife for this purpose. 

Q:  How does one work with a pseudonym and AuthorCentral 
A:  Amazon allows you to use different Author Central accounts for different pen names 
or you can link them to one account. Just don’t use someone else’s photo. it is illegal. 
Just get a different looking photo that is still you but has a different look. If you just want 
a pen name for the sake of having a pen name, don’t do it. The best success you will 
have in marketing your books is to tell people they are your books, so use a pen name 
only if you have a good reason. 

Q:  How many Facebook accounts can you have and fan pages/groups per account. 
A:  Technically, only 1 account. It goes against Facebook Terms of Service to have more 
than one (and if Facebook finds out, they can banish you), but some people do it with 
pen names. You can have as many pages or groups attached to an account and no one 
knows they are yours. There is no way people can know you are behind a group if you 
make someone else the admin. So the correct approach is to have a single profile and 
base all your pages and groups out of that one. 

Q:  is there a Publisher Central page? 
A:  No. You can have a publisher account through CreateSpace. Author Central, Seller 
Central and Amazon Associates are the accounts available within Amazon. There is not 
page where you can showcase all your books as a publisher 

Q:  Returns:  Ingram charges for returns 
A:  Yes and No. Technically, they will just not pay you royalties for returned books and 
you can opt to have them either send the books back to you or destroy the copies. Get 
them back when possible and re-sell them somewhere else. There are not a lot of 
returns in most cases. 

Q:  Do bookstores take books on consignment? 
A:  Yes, especially Indy mom and pop stores,  but it is hard to get paid for these and it is 
a nightmare. It is better to offer them a bigger discount to take more copies. 

Q:  How do you set up publishing company? 
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A:  It isn’t difficult to set up an LLC. MyCorporation.com is very good and efficient. You 
just pay them and they will take care of everything for you. Specifics like a d.b.a. are 
dependent on where you are located and you need to know your local rules/regulations. 
Talk to a lawyer and accountant in your area to find out what you need to do where you 
live. 

Q:  Does it make sense to approach art supply stores like Blick to sell your book? 
A:  It can’t hurt. Also, check out college bookstores. Indy stores are easier to get into 
than any corporate store and don’t forget your local library usually loves local authors. 
Depending on the market you are in, Comic Con events can be appropriate, too. It all 
comes down to the fact that you have to get out there and work it. 

Q:  In partnering with a charity, do we need to order and print a supply of books 
ourselves 
A:  Sometimes yes and sometimes no. It depends on how you have it set up. You can 
have someone sponsor the printing of your book and it would make more sense to go to 
a traditional printer because your costs are going to be much less per unit. If you are in 
a situation where you have a chance of moving a lot of books, you might want to 
consider an option like printninja.com, a US company that does its printing in China at 
fantastic rates if you are printing a lot of books — the minimum is 250. They do all types 
of bindings, paper weights and finishes, etc. Go to the site and test out some various 
bindings, paper and quantity combinations to see the kind of prices you can get per unit. 
Just keep in mind that because they are printing in China, there is shipping time you 
have to allow for. 

Q:  Does Amazon like Pinterest for Author Central? 
A:  There is no way to connect them, but it is a good idea to have some of your coloring 
pages on Pinterest. You can have a blog page with a page from your book you want to 
share. On that same article, include a link to buy your book from Amazon. Share that 
page on Pinterest and whenever someone goes to that page, there is a link to buy the 
book. Make it easy for people to buy your book. 

Q:  With pre-selling, why sell and ship yourself rather than using Amazon’s pre-order 
functionality? 
A:  You get real addresses that work because people are going to give you their 
shipping address. You can use in the future to follow up with them in the mail and for 
other kinds of marketing like announcements of a future book. In addition, instead of 
making the $2 royalty from Amazon, make $10 while driving traffic to your web site. 
Additionally, it is the only way to do autographed copies unless you are selling through 
Amazon’s FBA (a real pain) or doing a book signing somewhere. 

Q:  How do you know how many copies to order from printer in presell 
A:  Don’t print books in advance and then hope to sell them all. Keep track of your 
orders and then set an end date to close the pre-order window. You should know exactly 
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how many you need to have printed to fill the orders, have them printed and get them in 
about three days. You will want to specify on your pre-sell page to “allow 3-4 weeks for 
delivery.” 

Q:  In a giveaway, could you send losers a .pdf of pictures as consolation prize? 
A:  Amazon makes links to Amazon active in your page. They will let you put in an 
outside link address but will not make outside links active. People have to copy/paste. 

Q:  How many videos can you have in Author Central 
A:  According to Amazon’s web site, up to 8, no more than 10 minutes in length, and 
smaller than 500 mb. You must upload videos. You cannot link to a video on YouTube. 

Q:  Can you only run a giveaway for published books, not pre-selling? 
A:  Correct 

Q:  On back cover, why did use address for publisher rather than web address 
A:  Both were used 

Q:  If I don’t have a list, should I go through your training on list-building 
A:  Not a bad idea. Check out the Expert Media Show at www.expertmediashow.com  

Q: Can I use an ISBN owned by someone else?  Would I have to publish using the 
owner’s name? 
A:  You can partner and become an admin on that owner’s account and then request for 
a publishing imprint at myidentifiers.com but all those sales would pass through the 
owner’s account. The best practice is to have your own. It is illegal to buy ISBNs from 
anyone not an authorized reseller. They are not transferable from account to account. 
No partnering on buying a block is allowed unless you are a partnering publishing 
company. 

Q:  Buy reviews? 
A:  Do not pay for reviews. If you pay for reviews and Amazon finds out, they will 
terminate your account at Amazon. Don’t do it. 

Q:  Goodreads? 
A:  No need. There is nothing to read in a coloring book. 

Q:  I have book being published in August and would like to create a coloring book to 
complement it. Will I confuse customers or reduce sales by publishing both at the same 
time.  
A:  You probably shouldn’t do both at same time. Publishing companies have formulas 
for launch times because it works. Generally, the formula is 3-6 months between 
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different formats of the same book; 2 years between books. This gives them time to lock 
down publication and build a platform so you have someone to sell to. If you are six to 
eight months out on a book release, you can create the coloring book first to seed into 
the book. Or, you could wait until the book comes out in August and release the coloring 
book a couple of weeks later as a one time offer type of thing. In your book, mention the 
coloring book to be released. 

Q:  Popularity in publishing a combination journal/coloring book. 
A:  Any time you cross two niches that make sense to work together, you double the 
audience. 

Q:  How do you make lines in a coloring book for journaling? 
A:  Draw lines. Simple in Adobe InDesign and can be done in Canva as well 

Q:  Can you talk about coloring tools, pens/pencils/paints. 
A:  Really depends on the paper your book is printed on. Different people prefer 
different instruments. Prismacolor are the absolute best pencils, bleed through is not a 
problem, and they are very easy to blend. 

Q: How do you include hidden objects in your books 
A:  It is a simple matter of pre-planning. You have to determine ahead of time what your 
hidden objects are going to be and then add those as a layer on top of an illustration. 
Sometimes you can be obvious about it and other times you can work a little harder to 
move the object around and hide it within the illustration. Inserting an object into 
detailed patterns can be easily done in Photoshop. On a page in the front of the book, 
you can show a selection of the objects hidden in your illustrations and even the number 
of each that are hidden throughout. 

Q:  Can coloring books be interactive? 
A:  “Coloring” is interactive 

Q:  Where can you research antique coloring books in the public domain? 
A:  Do a Google search 

Q:  Is it better to create coloring books in a competitive theme or hot niche like gardens 
& pets or niche down and specialize 
A:  Do both. Competitive is competitive because it is selling, but we don’t know what the 
next big thing might be. There are some things (monster trucks or zombies, for 
example) that are probably not going to be “hot” as art therapy or relaxation. Just think 
about it and use common sense. 

Q:  Does it make sense to print in bulk at PrintNinja.com and send to Amazon for 
fulfillment by Amazon FBA? 
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A:  It is possible, but you really need to make sure the volume is there. If your book 
starts selling in a really consistent way, it may make sense to do that. But books have a 
shelf life and if they are not selling, Amazon can charge you storage fees and even send 
them back to you.  

Q:  Amazon has a “Verified Purchase” review system. How does it work with a review 
copy PDF strategy? 
A:  Amazon will post reviews that are not verified purchases. They just won’t show the 
words “Verified Purchase.”  Verified are ideal but the review PDF copies are a good way 
to seed the process of getting these. 

Q:  Can you explain what bleed is 
A:  When they print a book, it is printed larger than the final size and has to be trimmed 
or cut down to its final size. Bleed is the amount of an image that we add to extend 
beyond the final trim size in our layout to make sure the image on the final cover 
extends all the way to the trimmed edge and there isn’t a white or black line down any 
side or a paper color band around the cover image. 

Whether you think you can or think you can’t, either way you are right. 

             —Henry Ford
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